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Prerequisites & Expectations

Prerequisites
Windows PC available including internet connection

Expectation
How to install and begin working with Code Composer Studio and EVE Simulator
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Abstract

 EVE Simulator Installation process

— This presentation shows the installation process of Code Composer Studio
(CCS) and EVE simulator to begin working with EVE programming.

e Documentation and Links

— It will reference to all documentation required in order to develop and test
EVE software.

e Using EVE Simulator

— The presentation will guide you through the use of EVE simulator under
CCS and show how to import and debug first examples.
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EVE Documentation

EVE Getting Started
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EVE documentations

Latest documentation on CDDS (includes EVE Programmers Guide) :
https://cdds.ext.ti.com/ematrix/common/emxNavigator.jsp?objectld=28670.42872.18092.28443

VCOP CPU and Instruction set reference guide Functional specification of the vector core: architecture,
instruction pipeline, instruction set.

Embedded Vector Engine Programmer’s Guide Teach EVE programming from a high-level VCOP-C
language and system perspective. Has examples for
basic functions (point-to-point operation, filters) as well as
examples leveraging VCOP’s vision specific capabilities
(histogram, scatter-gather, repeat-loop).

VCOP Kernel C Reference Guide Description of the VCOP kernel compiler (vcc), a tool used
for programming the EVE Vector Core (VCOP) at a C-like
high-level language called VCOP-C.

EVE Subsystem Reference Guide Specification for modules that are not compute-related in
the EVE system: MMU, interrupts, safety features, SCTM,
SMSET.

ARP32 CPU and Instruction Set Reference Guide Description of the EVE’s scalar core architecture and

instruction set. Since APR32 is programmed in C, reading
this document is optional.

ARP32 Compiler Reference Guide Description of the ARP32 C-compiler tool usage. The
reading of this document can be skipped.

ARP32 Assembly Language Tools Reference Guide Description of the ARP32 Assembly Language. The
reading of this document can be skipped.
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EVE Tools and Software package
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Obtaining tools for installation

 EVE simulator works with Code Composer Studio Version 5.2
(CCSv5.2)

— Download CCSv5.2 at the following link:
(http://processors.wiki.ti.com/index.php/Download CCS)

— For introductory information on CCSv5:
(http://processors.wiki.ti.com/index.php/CCSv5 Getting Started Guide)

 EVE simulator tools download from Tl
— EVE Simulator Pack available for customers with NDA signed
— Please contact your local Tl representative for download location
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EVE — Simulator Install

The following steps describe the installation process for EVE simpack.
1. Install CodeComposer Studio (CCS5.1 or newer)

2. Install EVE Simulator Pack (ti_simpack csp eve_setup X.X.X.X.exe)

For CCS5.2 select destination

location ...\ccsvb5\ccs_base

. Fle Edt view Favorites Tools Help
The installer creates one folder Qo - © - 3| Pt o | 13 3 X Q| [~ & &
1 1 b Add : b G
,Simulation eve CsSp” at ccs base L | CThecsvBiccs base - ¥ @s
- - _ Folders Mame Size  Type
N R ~ Dceflo_1.0.0.201110191212 File Folder
. . 5 ARPA2_took [cEFloRepo File Folder
Documentations are available 5 bs630.05_54 Ceme FeFo
B[ cesvs Cdsbuldrapo File Folder
) ccs_base (Dhdvt File Folder
1 fs! Chdvt 3.1.0.201110191212 File Folder
in the subfolder docs/releasenotes S SavRese e Foc
' Declipse File Folder
Qe ‘DS? [emulation File Folder
| idebuildRepo Diincude File Folder
12 tools C3aripting File Folder
|2 utils (simulation Filz Folder
2 edma3_lid_02_11_01_02 Dhsimulation_csp_ry File Folder
) eve_sw_release :ls?mulat?onfcspftn F?Ie Folder
5 HOVPSS_01_00_01_27 (Shsimulation_ewve_csp File Folder
B Eine 123 N5 an 1
< > < >
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ARP32 Code Generation Tools Install

1. In the CCSv5 main window, select Help-
>Install New Software...

This brings up the Available Software
window.

2. In the Available Software window, type the
EVE P2 installation server

URL into the "Work with:" text box, and
press Enter.

Server URL:

Win32:http://software-
dl.ti.com/dsps/dsps_public_sw/sdo_ccstudio/
CCSv5/Updates/cgtools/ARP32/p2win32

Linux:http://software-
dl.ti.com/dsps/dsps_public_sw/sdo_ccstudio/
CCSvb/Updates/cgtools/ARP32/p2linux

The contents of the site should appear in
the selection area in the middle of the
window. You should see "CCSv5
Windows updates”.

3. Expand "CCSv5 Windows updates".

- You should see "EVE Compiler Tools

¥

'+ Install

Available Software
Check the items that you wish to install,

Work with:

type filter text

MName
4 00 CCSvs Windows updates
4+ EVE Compiler Tools v1.0.0 (Beta 6)

| SelectAll | | Deselect Al 1 item selected

Details

Show only the |atest versions of available software

[V] Group items by category

[7] Show only software applicable to target environment

[#] Contact all update sites during install to find required software

http://software-dl.ti.com/dsps/dsps_public_sw/sdo_ccstudio/CCSv5/Updates/cgtools/ARP32/p2win32 -

o [ e
.=
2=

Find more software by working with the "Available Software Sites” preferences.

Wersicn

0.0.6

[ Hide items that are already installed

What is already installed?

v1.0.0 (Beta 6)". @ < Back Next > Finish
4. Select the EVE Compiler Tools checkbox,
then click "Next>".
9
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EVE software package

 The EVE software package provides the following
components:

evestarterware xx_xx_xx_xx: library and source code of functions to
control different modules of the EVE subsystem.

evelib_xx_xx_xx_xx: kernel-C code of vision, image and signal processing
functions and example codes using them.

o arp32_cgt xxx in avdsk xx_Xxx_xx_xx directory: arp32 codegen tools. May
be absent if you downloaded a late version of the EVE software package. In
this case use Code Composer update to obtain the tools.

Since the Makefiles released with the evelib’s examples use the harcoded
path C:\Program Files\Texas Instruments\ARP32_tools, need to copy
ARP32_tools installed in your CCS directory to the aforementioned path.

 EVE software package download from CDDS

— EVE software package is available for customers with NDA signed
on CDDS

— As coordinated by your local Tl contact you will be receiving a link to
make general registration on the CDDS database system.
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EVE and CCS v5.2
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CCS View modes

 Open CCSv5 will prompt to select or create a workspace

It is recommended to create one workspace for EVE development

@ Warkspace Launcher @

Select a workspace

Code Composer Studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Warkspace: | e WCCSYSWorkspace_EVE]

V| [ Browse...

[ uUse this as the default and do not ask again

[8]4 ] [ Cancel
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CCS View modes

« Creating a new workspace CCS comes up with the welcome page

* Close the page using the tap “TlI Resource Explorer”

1 CCS Edit - T Resource Explorer - Code Composer Studio

Fla Edt view Nasvigate Project Run Sorpts Window  Help
R | oS edt
(/) Tl Resource Expiorer 1
& Packages: wekcme v Devees: Topkes: Al
URL!
Welcome to Code Composer Studio v5
You can bring this page up al any lime by selecting Welcome from the Help menu
= <~ Highlights
A
W4 Examples
BT (mporeros
2 J—
G Web Resources
[ =
Licersad &
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CCS View modes

e One click to the “Open Perspective” button will add the CCS Debug
perspective (small button on the left of the CCS Edit button).

0 hems

Licersed 0 items selectad
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CCS View modes

* Two default perspectives are available
— CCS Edit perspective to manage SW projects including coding
— CCS Debug perspective to debug the system using simulator or emulator

&? cCS Debug - Code Composer Studie

& - TR < SR g 7Y S CCs Edt %5 cos Debug |

v =5

i
%% Debug = O 0= variables 92 | & Expressions | M Registers )% B
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Load existing EVE SW projects

o Switch to CCS Edit perspective and import existing projects

I cic++ - Code Composer Studio (Licg

— Menu: File>Import

— Select “Existing Projects into Workspace”
— Browse and select “..\eve_sw _release” folder.

— Select first example and deselect all others

— Don't tick the option:

« “Copy projects into workspace”

— Complete with “Finish”

L] Import

(%) Select root directory: | ram files\texas instrumentsieve_sw_release ‘ I Browse. ..

O Selert archive fie: | |

Projects:
array_add_uns_char A select Al
[¥] array_add_uns_char_inth

i Deselect All

ar_inth_|
|_uns_short_ZNPT
_add_uns_short_2NPT_kernelZ
ay_add_uns_short_C
|_uns_shork_intly_i
|_uns_short_intly_kernelC

bdti_vecprod_kernelC
balti_vecprod_src_¢ 5

D Copy projects into workspace

Import Projects —
Select a directory to search for existing Eclipse projects, ; ,

GIEN Edit  View Mavigate Project  Target

Mew Al+shift+n ¥
Mew File...
Open File. ..
L) Import
Select
Create new projects from an archive file or directory
Select an import source:
| type filter text
Refresh F5
Convert Line Delimiters To L4

— Switch Workspace. .,
=L Preferences

= o+
= ccs
= ovs £ Export...
= Team
Exit
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Build existing EVE SW project

« Select the project to build “Project tab > Build project”

* |If the system responses with the following error:
— Copy the folder “ARP32_tools” into
— C:\Program Files\Texas Instruments oIRGB Rkttt cse

%‘:,Rebuild Active Project Alt+5Shift+F

- B u I I d ag ai n @Import Existing CCS/CCE Eclipse Project

® Import Legacy CCSv3.3 Project
e array_add_uns_Jiechliiisies :

fC++ - Code Composer Studio (Licensed)

Lol veop_aray_ade 2 puid Al ChrHE
I
- [8] veop_array_ada &yRebuid Al al+6
3 conscle 22| . Problems $ 45 el E-5- =0 [€] veop_array_adc
COT Buld Consdle [array_add_uns_char_src_C_CCS_Makefile] | @ Makefile
. . . ) . |=| woop_array_adg
*#x*%%* Build of configuration Default for project array_add uns_char src C_CC3 Makefile ****
gnake all | Build Project
"C:\Program Files\Texas Instruments\ARP3Z_tools\bin\cl-arp3Z.exe" -o03 -I "C:\Program Files\Texas Build Working Set v
InstrumentshARE3Z tools"\include -I ..\inch -c --silicon version=v210 .\vec array add uns char c.c ulid wrarking &
--obj_directory "..\elf_out" vec_array add_uns_char_c.obj Clean..

The system cannot find the path specified.
gmake: *** [vec array add uns_char c.obj] Error 1

Ewild Automatically

Link Files to Active Project. ..
Add Files to Active Project. ..

#%%#% Build Finished #*#**

Properties
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Build existing EVE SW project

 Once build was successful the executable file can be found

— Location: “<Project_folder>\elf out” folder
— Executable name: “<Project_name>.out”

18
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Target creation for EVE simulator

e Create a Target Configuration within the CCS Debug perspective
— Menu: “File>New>Target Configuration”

% Dobug - Code Composer Studio [Licensed)

* 0| Local (1) Watch | M Begsters (1) &2

Pl Wik

Eile =1 |ev |
[¥]use shared |
— G iVe a fi Ie name to Create a targ et Location: | {\Documents ans d Settin 0530393294 user|CCSTan ‘getCon figurations | Workspace..
1
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Target creation for EVE simulator

o Select “EVE(45nm)1.0 Simulator, Little Endian” as the

device

— Typing “eve” in the device filter will show eve simulators only

o Complete with “Save” button and close window

B eve.coxml 28 =08|=
Basic
General Setup Advanced Setup
This section describes the general configuration about: the target.
Connechion | Teyas Instruments Simulator w Target Configuration: lists the configurat
Device

tvpe filker text
Save Configuration

[ ARMFTDMI CPU Cycle Accurate Simulator, Big Endian
[ ARMFTDMI CPU Cycle Accurate Simulator, Little Endis
[ ARMSZEE1-S Device Cycle Accurate Simulator, Little £
[ aRMse CPU Cyele Accurate Simulator, Big Endian

] arM2e CPU Cycle Accurake Simulator, Litts Endian

[ 55w Reva.x CPU Cycle Accurate Simulator

[ c55mx Revz.x CPU Functional Simulator

[ 55 Rev3.0 CPU Cycle Accurate Simulakor

[ ©55:x Rev3.0 CPU Functional Simulator

[] o416 Device Cycle Accurate Simulator, Big Endian %
£ ?

Simulates the ARMFTDMI core in a cycle accurate
manner. Supports a flat memory system., Does nok
model any peripherals, This canfiguration is suitable for
core level algorithms dewvelopment and benchmarking
withiout the system effects,

Moke: Support for more devices mav be available from the update manager,

20
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Launch EVE simulator

File Edit View MNavigate Project

« Under menu “View” the target configurations window ; 28 5%
can be opened ) erget Configurations. X
type Filter text

* Right click on the eve target file and choose = & e Defned

- Set aS DefaUIt [& New Target Configuraton

¥ Delete Dielete

* Right CIiCk again to Choose Qfi::r::rljSelecteclConﬁguranjon

— “Launch Selected Configuration” o :

The simulator will be launched.

21
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Launch EVE simulator

« EVE simulator provides all the basic debug features as such as

— Step in, Step over, Assembly in, Assembly over, Breakpoint and Reset

— The menu “View” allows to open further windows as such as “Disassembly”

&P CCS Debug - Source not found. - Code Composer Studio

Fr S % @ - & - [
%5 DebLg 2 0 3R
= ¥ eve.coxml [Code Composer Studio - Device Debugging]

= o EVE Simulater, Litle Endian_0/EVE (Suspended)
= 0x00000000 (ho symbols are defined for 0x00000000)

Eloxo 2

&

File Edit Wew Search Project Tools Run Scripts Window Help

& e ¥ 7 O iRegisters % | 4 Target Configurations

MName Yale

# i Core Registers

4 VCOP_Statis_Registers

&4 VCOP_Load_Registers

4 VCOP_Vector_Registers

## VCOP_Sim_Status_Registers
&% WCOP_address_Generators
@ ## VCOP_Parameter_Registers

B 5 CCSEdit % CCs Debug |

=5

4 &~ = O

Description

=8 isassembly &3

Mo source avalable for "0x0" | Enter location hiere v i 5B 2 2 e

=»00000000: 0oogpooo word 0x0000000 ~
ooonoooé: gooooooo word 0x00000000
oooopoog: Q0ooooooo word 0x00000000
ooonoo0c: gooooooo word Ox00000000
0ooooolo: Q0ooooooo word 0x00000000
oo0nool4: gooooooo word Ox00000000
0o00o0o018: gooooooo word 0x00000000
0o0000lc: gooooooo word Ox00000000
goonooz gooooooo word 0x00000000
goonooz gooooooo word Ox00000000
0oonoozs: gooooooo word 0x00000000
oo00ooZe: gooooooo word 0x00000000
0oo0o0o030: gooooooo word 0x00000000
0o00nooz4: gooooooo word 0x00000000
00000038: gooooooo word 0x00000000
0000003c: gooooooo -word 0x00000000
oo00oo4o: gooooooo ADD 0O, RO, RO
oooooo4 gooooooo ADD 0, RO, RO
oooooo4 gooooooo ADD 0O, RO, RO
oooooo4 gooooooo ADD 0, RO, RO
ooonooso gooooooo ADD 0O, RO, RO 3

i Licensed
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Load first executable into EVE simulator

« Hit the “Load” button to select the executable to be loaded
— The executable file can be found within the “<Project_folder>\elf out” folder

@ CCS Debug - Source not found
Fle Edt Yew Search Project Tools

ode Composer Studio

Run  Scripts  Window Help

[m]pd

it = T C [ R AR & 5 CCS Edit |#5 oS Debug |
%5 Debug i3 BB DD @~ & € ¥ 7 O|iRegsters 2| ¥ Target Configurations e Lo TR
= % eve.coxml [Code Composer Studio - Device Debugging] Mame Walus Description
=4 EVE Simulator, Litle Endian_0/EVE (Suspended) @ &% Core Registers
® & YCOP_Status_Registers
# & WCOP_Load_Registers
@ M4 WCOP_Vector_Registers
® M VCOP_Sim_Status_Registers
® ¥4 VOOP_address_Generators
@ et YCOP_Parameter_Registers
| >
Eloxo = & Load Program =i
1o soLrce avaiable for "0x0" nter location here v | | (mll e ™
Program fie | ralf_outveop_vec_array_add_urs_char Cout  » [B(cnw:_._] lHnou:c pﬁclr:ct..] noo0onn e Dx‘DD.DDDDDD 2
Code offeet nooooono -word Ox00o0o0oo T
Data offset o0oooooo ~word O0x00000000
ooooooo -word OxDO000O000
o0oo0oono -word 0x00000000
[Ll Caee o0oo0oono -word 0x00000000
- noooono ~word Ox00000000
0ooo00le: oooooooo ~word Ox0oopooon
onoooozo: oooooooo -word Ox0oopooon
ooooo0z4: gooooooo -word OxDO000000
00000028 : ooooooan -word 0x00000000
0000002e: ooooooan “word 0x00000000
0nooo0z0: oooooooo ~word Ox00000000 |
0nooo034: oooooooo -word Ox0000o0on
ooooo03s: gooooooo -word OxDO000O000
0000003c: ooooooan -word 0x00000000
0noooo4n: ooooooan ADD 0O, RO, RO
0nooon44: ooooooan RDD 0O, RO, RO
onoooo4s: oooooooo RDD 0O, RO, RO
onooo0de: oooooooo RDD 0O, RO, RO
ooooo0so: gooooooo ARDD 0O, RO, RO 3
o® Licensed
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Load first executable into EVE simulator

e On load completed the PC will be holding on main() with source file

opened.

$ CCS Debug - array_add_uns_char_src_C_CCS_Makefile/vec_array_add_uns_char_tb.c - Code Composer Studio

Fle Edit View Search Project Tools Run  Scripts Window Help

£ - @R e i Y [ CCSEdt [#5 ccs Debug |
#5 Debug 2 i 3 B S @ g s & 8 Y T O MRegisters 82| ® Target Configurations | £ B | it eeYy=SO
= §¥ eve.coxml [Code Composer Studio - Device Debugging] Mame Walle Description
= EVE Simulator, Little Endian_0/EVE (Suspended) ® &% Core Registers
d [ B VCOP_Status_Registers
= 0x400023FB (o symbols are defined for Ox400023FE) # ¥ VCOP_Load_Registers
@ 5 VCOP_Vector_Registers
@ &% YCOP_Sim_Status_Registers
# 4 WCOP_pddress_Generators
@ % YCOP_Parameter_Registers
< | -
Eloxo Ll vec_array_add_uns char_th.c 2 = O = Disassembly 32 =0
58 0x61, 0x63, 0x65, 0x67, 0x69, Ox6b, 0x6d, Ox6f, ~ Erter locatonhere  |v| &1 1 [&[B] 2 o i@ T
59 0x71, 0x73, 0x75, 0x77, 0x79, 0x7b, Ox7d, 0x7f Hain: ) A
100%: »80003d68: | D01C3EE1 SUB 2B, SP
10l ) 115 vcop_vec array add uns_char cn (A,
102 char pass_string[80] = {"Pass\0"}; B0003d60: 2246 MVES 4, R1 -
102 50003dée:  4001600A MWK 0x4001, R3
#1l0dint main() 80003d72: 00004002  MVK 0x0000, R2
0S5 i B0003d76:  O000800R  MVE 0x0000, R4
06 int fail; 80003d7a:  DB4a MVES 16, RO
107 int i; 80003d7c:  20FA 5TW R1, *+5E[1]
0o 50003d7e:  400S6CBA  MVKH 0x40050000, B3
05 S F oo T 80003d82: 40054883 MVEH 0x40050000, RZ
10 /* call the natural C implementation for the wector array add func. 200032486 : 40049085 MVEH 0x40040000, R4
11 /% which accepts input arrays B and B, adds "blk h" lines each of 20002484 0172 STW RO, *+50(2)
112 /% "blk w" points each, and returns the result in array "C". G0003d0c: 00159009 CALL vcop vec array add
113 S ittt ittt 80003490 O3FF HOP o T -
14 4 123 fail = memecmp (C, EOut, NO):
15 veop wec_array_add_uns_char_cn (A, B + 1, C, blk_h, blk w); 80003492 : 00004002 MVE 0x0000, R2
15 50003d56:  269CE00R  MVK Dx260c, R3
117 JFmmmm oo ST oo mmmmmomoo oo oo oo oo 80003d%a:  0040810A  MVKLS 64, R4
118 /* Perform a "memcmp" of the processed results in array "C" with GO003d9e: 40044005 MVEH 0x40040000, RZ
19 /*  the expected output array in "EOQut" over the "N" points of 20003daz : A0026CEE MVEH 0x40020000, R3 3

izl f*  cemrntatinm

E Licensed
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Learning from EVE examples

EVE simulator release contains an eve_sw_release directory

It contains N example implementations of
— ~100 algorithmic functions
— ~40 application & DMA projects

Great source to learn and apply knowledge to own functions (= N+1)

Can be used to copy/paste for building more complex algorithms

25
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